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Overview 

Sage Intelligence Reporting empowers you to quickly and easily obtain the information you need for 

improved reporting across your entire business.  Based on the familiar environment of Microsoft Excel, 

you can effortlessly create reports and analyse your data, improving visibility into your organization and 

helping you make informed business decisions. 

If you are a Sage Intelligence user previously using Financial Reporter (FR), you may have FR reports 

that you wish you could use in Sage Intelligence.  You may also be an existing FR user looking to move 

to Sage Intelligence but are wondering whether your reports will be compatible.  FR report specifications 

(specs) are not natively compatible with Sage Intelligence, however we will show you how you can 

convert them to Sage Intelligence Financial Report Designer layouts. 

The rest of this section lists some resources where you can find additional information on both Sage 300 

ERP and Sage Intelligence Reporting.  A list of requirements for converting specs is also provided.  In 

Section 2, some Sage Intelligence features are discussed.  These are Lists, Formulas and Trees and 

provides a foundation for Section 3 which draws a comparison between FR specs and Report Designer 

layouts.  A comparison of FR functions and Sage Intelligence formulas is provided in Section 4.  Lastly, 

we work through the process of converting FR specs to Report Designer layouts.  This process is 

outlined in the following image. 

1.0 Introduction 
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Additional Help 

To get some of the legalities out the way, please note that this guide is provided ‘as is’ to assist with the 

conversion process and is not supported by Sage ERP Support as per Sage Support Coverage terms.  This 

document is also not intended to serve as a guide to Sage 300 Financial Reporter or Sage Intelligence 

Reporting.  You are required to have an understanding of these products to successfully use it.  You can find 

more learning material on both of them through the following: 

Sage Intelligence 

 Sage Intelligence Reporting Help File – accessed from the Help menu in the Report Manager

 Sage 300 ERP Intelligence Reporting group on the Sage Intelligence Community:

http://www.sageintelligencecommunity.com/group/sage300erpintelligence

 Sage 300 ERP Intelligence Reporting category on the Sage Intelligence Forum:

http://www.sageintelligencecommunity.com/forum/categories/sage-300-erp-intelligence-

reporting/listForCategory

 Sage Intelligence YouTube channel:

https://www.youtube.com/user/SageIntelligence

 Sage Intelligence Academy:

http://www.sageintelligenceacademy.com/

Financial Reporter 

 Sage 300 ERP Help File under Home, General Ledger, Financial Reporter

 Sage 300 ERP 2012 or 2014 Financial Reporter User’s Guide

 Sage Accpac Financial Reporter Quick Reference Guide

 What You Need 

Before we begin, make sure you have the following: 

 An installation of Sage 300 ERP running FR

 The FR report specifications you want to convert

• Open spec

• Remove row suppression 
characters

• Generate report

• Copy worksheet to Report 
Designer

Run FR 
Report

• Replace report headings

• Add new columns headings

• Update account numbers 
and descriptions

• Add SI formulas

• Update totals

• Update report headings

Update SI 
Report Layout • Leave workbook open

• Save Excel Template in 
Report Manager

Save Layout

• Hide zero rows

• Reporting trees

Extras

http://www.sageintelligencecommunity.com/group/sage300erpintelligence
http://www.sageintelligencecommunity.com/forum/categories/sage-300-erp-intelligence-reporting/listForCategory
http://www.sageintelligencecommunity.com/forum/categories/sage-300-erp-intelligence-reporting/listForCategory
https://www.youtube.com/user/SageIntelligence
http://www.sageintelligenceacademy.com/
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 A Sage Intelligence Report Manager and Report Designer licence

 Microsoft Excel 2007 or later
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The Sage Intelligence Report Designer gives you two options to design your report layouts, the Layout 

Generator and the Task Pane.  The Layout Generator lets you design meaningful layouts using an 

intuitive drag and drop interface and is intended for users who are not very familiar with Excel.  The Task 

Pane on the other hand allows you to take complete control of your design using Microsoft Excel’s 

powerful functionality but requires a good understanding of Excel. 

Layout Generator: 

Although it’s possible to create layouts similar to your FR specs using the Layout Generator, we are 

going to focus on using the Task Pane as it allows for an easier process and provides you with more 

flexibility. 

The Task Pane is comprised of three tabs: Lists, Formulas and Trees.  These are fundamental to 

understanding the comparison between FR specs and Sage Intelligence report layouts.  Familiarity with 

them will also help in the conversion process.  Each will be discussed briefly. 

Lists 

Lists are retrieved from the General Ledger and contain key information like accounts and budget codes. 

They are used to create report rows and their fields can be added to formula arguments to extract 

specific data.  The lists included in Sage 300 ERP Intelligence Reporting are Accounts, Currency, 

Account Structure, Account Groups, Account Segments, Budgets Sets and Segment Codes. 

2.0 Sage Intelligence Concepts 
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Formulas 

Formulas return balances or header information from your general ledger based on provided arguments 

which act as filters.  Examples of arguments are Account Number, Current Year and Current Period.  

Each argument can be a cell reference, constant, or named range.  All arguments for each formula are 

explained in the Sage Intelligence help file. 

Formulas let you define columns for your layout where the type of formula used determines the purpose 

of the column, for example, to view the Actual or Budget amounts for a period. 

Trees 

A Reporting Tree allows you to define a reporting structure according to the hierarchy of your business 

and then view your data based on that hierarchy at the click of a button.  Although it’s not necessary to 

create a Reporting Tree for a report, they do allow you to filter your data over and above the filters 

commonly used in formulas. 
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Each of the sections in this chapter looks at an aspect of an FR spec and how it translates to Sage 

Intelligence.  The FR component or concept is first described and then an explanation is given of how 

this can be replicated or understood in Sage Intelligence. 

Comments 

In FR, any text entered in column A beginning with ‘..’ is treated as a comment and is excluded from the 

report when it is run.  It is therefore excluded from the print area and will not show when the report is 

printed. 

Sage intelligence does not have a comment identifier.  If you want to include comments you can enter 

them as free text and set the print area of your layout to exclude them.  They will then not be visible 

when you print your layout. 

Report Headings 

FR allows you to enter reporting headings using free text and also provides a number of functions to 

show company and fiscal calendar information.  For example, =FR("Coname") returns the company 

name and =FR("Year") returns the Fiscal Year. 

3.0 Drawing a Comparison Between FR and Sage 
Intelligence 
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Sage Intelligence also allows you to enter report headings as free text and provides three formulas to 

display company and calendar information.  These formulas can be dragged into cells which can be 

referenced by other formulas.  They can also be added directly to other formulas as arguments. 

Formula Description 

Company Name 
Returns the full company name from your general ledger after applying the 

company code filter specified as an argument. 

Current Year 
Returns the current fiscal year from your general ledger after applying the 

filters specified as arguments. 

Current Period 
Returns the current period from your general ledger after applying the filters 

specified as arguments. 

 Column Headings 

In FR column headings can be entered using free text. 

javascript:hhctrl.TextPopup('argument:%20a%20value%20that%20provides%20information%20to%20a%20formula%20in%20order%20to%20filter%20data','Microsoft%20Sans%20Serif,8',10,10,00000000,0xc0ffff)
javascript:hhctrl.TextPopup('A%20period%20is%20the%20monthly%20operating%20cycle%20of%20a%20company%20for%20which%20accounting%20information%20is%20collected%20and%20reported.%20For%20example,%2001%20=%20March%20when%20a%20fiscal%20year%20ends%20in%20February.','Microsoft%20Sans%20Serif,8',10,10,00000000,0xc0ffff)
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In Sage Intelligence, column headings can be entered using free text.  Excel functions can also be used 

to calculate calendar information that relates to column headings, for example, the periods in a Rolling 

Income Statement. 

Default Rows 

FR allows you to create default rows.  A default row defines formats and functions that can be applied to 

one or more account rows.  This saves you time by only having to type out arguments and functions 

once. The default row is then applied to all rows below it until another default row is defined. 
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Sage Intelligence doesn’t make use of default rows.  It achieves efficiency by letting you drag lists and 

formulas into a layout.  Lists can be edited by deleting rows or columns that aren’t needed or inserting 

blank rows or columns to group similar items. 

You can drag formulas into a single row and edit its arguments, either using the Formula Bar or the 

Function Arguments window.  Excel copy and paste functionality can then be used to quickly and easily 

copy the formula to all rows in a group of accounts, or the entire layout. 

Account Rows 

FR lets you create account rows by typing functions, arguments or free text into the cells of a row.  

Columns A to D are reserved for specific parameters and are excluded from the final report.  Each 

column is discussed individually below.  Columns E onwards are used to specify the actual information 

that will appear in the report. 
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Account rows in Sage Intelligence can be created by typing the necessary arguments and text into a row 

or by dragging lists and formulas into the layout and editing them.  There are no reserved rows or 

columns so the layout you create is the end result.  If there is information in your layout that is required 

but that you don’t necessarily want to see, you can hide the rows or columns.  Alternatively you can 

define a print area to show only the rows and columns that you want to see in a printed version of your 

report. 

 

 Account Numbers 

Apart from entering comments and designating a default row, column A in a spec is reserved for entering 

account numbers.  Individual account numbers, ranges or wildcards can be used.  As an example, in the 

spec in the screenshot below the %% wildcard is used to tell FR to consider all accounts for the account 

row when the report is run. 
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In Sage Intelligence, account numbers or other account information, like account group codes for 

example, can be typed into a cell or can be obtain by dragging the appropriate list into your layout.  Sage 

Intelligence allows for ranges, wildcards and mathematical functions to be used to group account rows.  

Account numbers are not limited to a specific column. 

 

 Data Selection 

In a spec, column B is reserved for entering selection criteria.  The range of accounts entered in column 

A is then filtered or restricted by the selection criteria. 
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In Sage Intelligence, each financial formula can be filtered by a number of criteria to return specific data.  

For example, the Actual Year to Date formula can be filtered by account, company, year, period, account 

group code, group category code, account structure code, balance type, currency code, currency type 

and reporting tree unit.  These arguments can be entered into a formula as you would the arguments in a 

standard Excel formula, either in the Formula Bar or using the Function Arguments window. 

 

 Removing Rows 

In a spec, column C is used to remove rows that meet certain criteria from a report.  For example, you 

can exclude zero balance rows by placing a Z against all account rows or in all default rows. 
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Sage Intelligence uses the ZeroingII add-in to remove rows that meet certain criteria from a report.  The 

add-in is configured for a report in the Report Manager.  The add-in however only works on a report at 

runtime and there is currently no functionality to dynamically hide or show certain rows once a report has 

been run out.  Macros can be used to achieve this. 

We do currently have a Dynamic Range Manager feature on our development backlog that may be 

released in the next version of Sage 300 ERP Intelligence Reporting.  This feature will let you exclude 

zero rows from layouts in the Report Designer at the click of a few buttons. 

Grouping 

Column D of a spec is used to determine whether accounts will be consolidated or not.  For example, the 

value D will print a separate line for each account in the range of accounts and T will return a total for the 

range. 
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Sage Intelligence doesn’t currently have dynamic account ranges when using the Task Pane to design 

layouts (this is provided for in the Layout Generator through the Show Account Detail option).  In other 

words, account groups can be created using ranges, wildcards and mathematical functions, but there is 

no way to automatically expand a group to list all included accounts.  The Dynamic Account Manager 

feature mentioned in the previous section is intended to solve this problem. 

To list all the accounts in a range you can drag the Accounts list into a layout.  You can then group 

similar accounts by inserting blank rows between the different groups. 

 

 Sorting 

In FR, arguments can be added in column A of a default row to set the sort order of accounts in the 

default row area.  Arguments can also be included in column A of an account row to determine the sort 

order of accounts.  Certain arguments used in column D of a spec can also influence the sort order. 

 

In Sage Intelligence, accounts or account groups are shown in the order that they are entered in a 

layout.  If lists are used, the items in a list will have a predefined sort order.  The sort order for each list is 
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given in the table below.  Once a list has been dragged into a layout, Excel’s Sort function can be used 

to sort the list by one or more columns. 

List Sort Order 

Accounts Full account number 

Currency No sort order 

Account Structure Structure code 

Account Groups Sort code 

Account Segments No sort order 

Budget Sets No sort order 

Segment Codes No sort order 

 

 Account Descriptions 

FR provides a number of functions to enter account description information.  For example, 

=FRACCT("ACCTDESC") can be used to return the account description of an account.  Alternatively 

free text can be used. 

 

In Sage Intelligence, account description information can be entered using free text, otherwise the 

relevant information is included in lists.  For example, the Accounts list includes the Account Description, 

Account Group Name and Group Category Description of an account. 
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 Financial Formula 

FR includes a large number of functions to return balance or net amounts.  They can be used in default 

rows or in individual account rows. 

 

The formulas provided in Sage Intelligence to return financial amounts are listed with their descriptions in 

the table below. 

Formula Description 

Opening Balance 
Returns the opening balance general ledger amount after applying all the filters 

specified as arguments. 

Closing Balance 
Returns the closing balance general ledger amount after applying all the filters 

specified as arguments. 

Actual 
Returns the month to date general ledger actual amount after applying all the 

filters specified as arguments. 

Actual YTD 
Returns the year to date general ledger actual amount after applying all the 

filters specified as arguments. 
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Budget 
Returns the month to date general ledger budget amount after applying all the 

filters specified as arguments. 

Budget YTD 
Returns the year to date general ledger budget amount after applying all the 

filters specified as arguments. 

Quantity 

Is used for statistical reporting and returns the quantity information in a 

financial report, such as number of units, from your general ledger, after 

applying the filters specified as arguments. 

 

 Switch Sign 

In FR you can enter a minus sign in the function column of an account row to switch the sign of accounts 

in that row.  For example, when using a FRAMTA formula in an income statement, you would switch the 

sign of all Revenue accounts in the spec. 

 

In a similar way, you can switch the sign of Sage Intelligence formulas.  To do so either place a minus 

sign at the start of a formula or multiply the formula by -1. 
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 Subtotals 

In a spec, Excel formulas are used to create subtotals. 

 

Similarly, Sage Intelligence also uses Excel formulas for subtotals. 

 

 Drill Downs 

The FR functions FRTRN and FRTRNA retrieve totals from transaction history.  Specs that use these 

functions allow you to drill down to transactions once a report is generated.  You can identify cells to drill 

down on by the comment marker in them.  Once you right click on a cell and select FR Drill Down, the 

transactions appear in a new grid style window. 
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You can drill down on all Sage Intelligence financial formula.  To do this, right click on a cell containing a 

formula and select Drill Down.  The results will open in a new sheet in Excel.  If the formula you drill 

down on is returning a single balance, then the drill down will return the transactions that make up the 

balance in a sheet called Drill Transactions.  If on the other hand the formula you are drilling down on is 

returning the accumulation of multiple balances, then the drill down will first return all the individual 

balances in a sheet called Drill Balance.  From there you can drill down to the transactions of each 

balance. Note that you can only drill down on cells containing a single Sage Intelligence formula. 
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In Financial Reporter, FRAMT, FRAMTA, FRTRN and FRTRNA are the primary functions that return 

financial amounts.  The values they return are the same for a given argument.  Their differences are 

summarised in the table below. 

Function Value Sign 

FRAMT 

Returns balance and 

net amounts from 

account history. 

Respects the account type.  Debit balances in debit 

accounts and credit balances in credit accounts are 

returned as positive numbers; credit balances in debit 

accounts and debit balances in credit accounts are 

returned as negative numbers. 

FRAMTA 

Returns balance and 

net amounts from 

account history. 

Returns all debit balances as positive numbers and all 

credit balances as negative numbers regardless if the 

account is a debit or credit type. 

FRTRN 

Returns only net 

amounts from 

transaction history. 

Respect the account type.  Debit balances in debit 

accounts and credit balances in credit accounts are 

returned as positive numbers; credit balances in debit 

accounts and debit balances in credit accounts are 

returned as negative numbers. 

FRTRNA 

Returns only net 

amounts from 

transaction history. 

Returns all debit balances as positive numbers and all 

credit balances as negative numbers regardless if the 

account is a debit or credit type. 

 

The following two tables show Net and Balance arguments for the FRAMT, FRAMTA, FRTRN and 

FRTRNA functions.  This is not a complete list but a selection intended to guide you in learning how to 

translate FR functions.  An equivalent Sage Intelligence formula or method of obtaining the result is 

provided for each argument.  In many cases, additional Excel functions can be used to enhance the 

formulas.  For example, using IF, QUOTIENT and MOD functions to determine the correct year, quarter, 

half or to date values. 

Note: If drilling down is a requirement for you then this will make most of the suggestions in the SI 

Formula column of the below two tables redundant.  In this case you will need to follow the additional 

suggestions in the Notes column. 

 

Net Arguments for FRAMT, FRAMTA, FRTRN and FRTRNA Functions 

Argument Description SI Formula Notes 

NETP Current period Use Actual with current 

period. 

 

NETLP Last period If current period is 1, 

then use Actual with 

current year minus 1 

and period 12. 

 

4.0 Translation of FR Functions to Sage Intelligence 
Formulas 
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Otherwise use Actual 

with current period 

minus 1.  

NETnP nth period Use Actual with nth 

period. 

 

NETnPA n periods ago If n is greater than or 

equal to current period, 

then use Actual with 

current year minus 1 

and current period plus 

12 minus n.  Otherwise 

use Actual with current 

period minus n. 

 

NETQ Current quarter (to end) If in first quarter, use 

Actual YTD with period 

3.  Otherwise use 

Actual YTD with last 

period of the current 

quarter minus Actual 

YTD with last period of 

the previous quarter. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

 

Note that FR returns 

the net amount up until 

the period you generate 

a report for.  The same 

result as NETQTD. 

NETQTD Current quarter to date If in first quarter, use 

Actual YTD with current 

period.  Otherwise use 

Actual YTD with current 

period minus Actual 

YTD with last period of 

the previous quarter. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

NETnQ nth quarter If n equals 1 then use 

Actual YTD with period 

3.  Otherwise use 

Actual YTD with last 

period of nth quarter 

minus Actual YTD with 

last period of the 

quarter before that. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

NETnQTD nth quarter to date If n equals 1 then use 

Actual YTD with current 

period modulo 3.  

Otherwise use Actual 

YTD with last period of 

previous quarter plus 

current period modulo 3 

minus Actual YTD with 

last period of previous 

quarter. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

NETS Current half year (to end) If in the first half of the 

year, use Actual YTD 

with period 6. 

Alternatively, use 

Actual for each period 
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Otherwise use Actual 

YTD with period 12 

minus Actual YTD with 

period 6. 

in the range and sum 

the result. 

 

Note that FR returns 

the net amount up until 

the period you generate 

a report for.  The same 

result as NETSTD. 

NETSTD Current half year to date If in the first half of the 

year, use Actual YTD 

with current period.  

Otherwise use Actual 

YTD with current period 

minus Actual YTD with 

period 6. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

NETLS Last half year If in first half of the 

year, use Actual YTD 

with prior year and 

period 12 minus Actual 

YTD with prior year and 

period 6.  Otherwise 

use Actual YTD with 

period 6. 

Alternatively, use 

Actual for each period 

in the range and sum 

the result. 

NETLSTD Last half year to date If in first half of the 

year, use Actual YTD 

with prior year and 

period 6 plus current 

period minus Actual 

YTD with prior year and 

period 6.  Otherwise 

use Actual YTD with 

current period modulo 

6. 

Alternatively, use 

Actual for each period 

in the range and sum 

the results. 

NETY Total year Use Actual YTD with 

period 12. 

Alternatively, use 

Actual for each period 

in the range and sum 

the results. 

NETYTD Year to date Use Actual YTD with 

current period. 

Alternatively, use 

Actual for each period 

in the range and sum 

the results. 

NETCLOSE End of year 1 Not available.  

NETADJ Period 14 adjustments Use Actual with period 

equal to 14. 

 

NETP.2020 Current period for year 2020 Use Actual with current 

period and year equal 

to 2020. 

 

NETP.L1 Current period for previous year Use Actual with current 

period and current year 

minus 1. 
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NETP.N1 Current period for next year Use Actual with current 

period and current year 

plus 1. 

 

QNETP Quantity for current period Use Quantity with 

current period. 

 

 

Balance Arguments for FRAMT and FRAMTA functions 

Argument Description SI Formula Notes 

BALP Current period Use Closing Balance 

with current period. 

 

BALLP Last period If in period 1, use 

Closing Balance with 

prior year and period 

12.  Otherwise use 

Closing Balance with 

current period minus 1. 

 

BALnP nth period Use Closing Balance 

with period equal to n. 

 

BALnPA n periods ago If n is greater than or 

equal to current period 

then use Closing 

Balance with prior year 

and current period plus 

12 minus n.  Otherwise 

use Closing Balance 

with current period 

minus n. 

 

BALQ Current quarter (to end) Use Closing Balance 

with last period of 

current quarter. 

Note that FR returns 

the balance amount up 

until the period you 

generate a report for.  

The same result as 

BALQTD. 

BALQTD Current quarter to date Use Closing Balance 

with current period. 

 

BALnQ nth quarter Use Closing Balance 

with the last period of 

quarter n. 

 

BALnQTD nth quarter to date Use Closing Balance 

with first period of 

quarter n minus 1 plus 

current period modulo 

3. 

 

BALS Current half year (to end) Use Closing Balance 

with last period of the 

current half. 

Note that FR returns 

the balance amount up 

until the period you 

generate a report for.  
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The same result as 

BALSTD. 

BALSTD Current half year to date Use Closing Balance 

with current period. 

 

BALLS Last half year If in first half of the 

year, use Closing 

Balance with prior year 

and period equal to 12.  

If in second half of the 

year, use Closing 

Balance with period 

equal to 6. 

 

BALLSTD Last half year to date If in first half of the 

year, use Closing 

Balance with prior year 

and period equal to 6 

plus current period 

module 6. If in second 

half of the year, use 

Closing Balance with 

period equal to current 

period modulo 6. 

 

BALY Total year Use Closing Balance 

with period equal to 12. 

 

BALYTD Year to date Use Closing Balance 

with current period. 

 

BALOPEN Beginning of year Use Opening Balance 

with current year. 

 

BALCLOSE End of year Use Closing Balance 

with closing period. 

Note that FR returns 

the balance amount up 

until the period you 

generate a report for. 

BALP.2020 Current period for 2020 Use Closing Balance 

with current period and 

year equal to 2020. 

 

BALP.L1 Current period for last year Use Closing Balance 

with current period and 

current year minus 1. 

 

BALP.N1 Current period for next year Use Closing Balance 

with current period and 

current year plus 1. 

 

QBALP Quantity for current period Use Quantity for each 

period in the range and 

sum the result. 
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The high level process of converting FR specs can be seen in the diagram below.  Each step is then 

dealt with in detail in the sections below. 

 Prepare the FR Specification for Conversion 

The first step is to generate an instance of the spec we want to convert to use as the basis for the 

conversion. 

1. Open Sage 300 and sign in as ADMIN selecting SAMINC as the company

2. Open Statement Designer

3. Open the spec that you want to convert

4. Remove all row supressing characters from column C of the spec.  This ensures that all accounts are

displayed when the report is run

• Open spec

• Remove row suppression 
characters

• Generate report

• Copy worksheet to Report 
Designer

Run FR 
Report

• Replace report headings

• Add new columns headings

• Update account numbers 
and descriptions

• Add SI formulas

• Update totals

• Update report headings

Update SI 
Report Layout • Leave workbook open

• Save Excel Template in 
Report Manager

Save Layout

• Hide zero rows

• Reporting trees

Extras

5.0 The Process of Converting Reports from FR to Sage 
Intelligence 
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5. Run the report using FR View.  In the options screen do the following: 

a. Select a Year and Period that contain financial data 

b. Set the From account to the first account in the list of accounts and the To account to the last.  

This will ensure that all accounts are taken into consideration when the report is run 

c. Check the boxes to include Audit Information and Formulas 

d. Click OK 

 

The report will run and will display below the spec area. 

6. Create and run a copy of the Sage Intelligence Financial Report Designer.  At this point we want to 

open the Report Designer so that we can copy the FR report we have just generated to it. 

a. Open the Report Manager 

b. Create a copy of the Financial Report Designer 

c. Select the copy you have made and click Run 
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d. When selecting the Year parameter for the report, make sure you select the same year that you

selected when running the FR report

7. Copy the spec sheet from the spec workbook to the Report Designer workbook

a. Right click on the sheet name and select Move or Copy.  The Move or Copy dialogue will appear
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b. For To book, select the Report Designer workbook 

c. For Before sheets, select (move to end) 

d. Check Create a copy 

e. Click OK 

 

From this point on you will only be working with the Report Designer workbook. 

Note: It’s important that you don’t run the Report Designer report before you open Statement Designer 

as Excel will not let you copy the sheet across. 

8. Delete all rows that are part of the spec range 

a. Select all rows that are part of the spec range 

b. Right click on one of the selected rows’ handles 

c. Select Delete 

 

9. Lastly, clear the Print Area 

a. Select the Page Layout tab on the ribbon 

b. Click the Print Area icon 

c. From the drop down, select Clear Print Area 
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Your report will look as follows: 

 

 

 Update the Report 

Now that the report is in the Report Designer, we can update it to make use of Sage Intelligence 

methods and functionality. 

1. Replace the existing report headings with new ones 

a. Delete the existing headings 
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b. Add new headings to column D of the layout.  The new headings should include a report name

and the titles: Company, Year, Period, Currency, Currency Type and Reporting Tree Unit.

The information that is entered against these titles will serve as arguments for the Sage Intelligence 

formulas that are added to the layout. 

c. Enter SAMINC next to Company and enter the same year and period you selected when running

the spec report next to Year and Period respectively

Note: 

When running the Report Designer report on multicurrency data, Sage Intelligence formulas need to 

include the currency and the currency type to return the correct data.  You don’t need to add these 

now as SAMINC is a single currency company.  We will however make space for them now and 

shortly reference them in the formulas that we add to the layout.  This will allow the report to be used 

with multicurrency data in the future.  If you do not intend to use the report on multicurrency data then 

you do not need to include them. 

Similarly, we have included a field for a Reporting Tree Unit.  If you later decide to add Reporting 
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Trees to the layout, this field will be available for you to add your Reporting Tree unit. 

 

Sage Intelligence formulas include other arguments.  These are explained in the Sage Intelligence 

help file.  If you would like to be able to filter your data quickly by these arguments then you can also 

include them as report headings in your layout.  You may need to add some extra rows to the layout 

for this. 

2. Add new data column headings to the report 

a. Copy the existing data column headings and paste them on the same row, to the right of current 

ones 

b. Change the text of the new headings if need be 

 

3. Enter account numbers for all account rows in column D of the layout.  These can be copied the 

from the ACSEGVAL01 argument in column B of the layout. 

Tip: To save time, use an Excel MID function in column C of the first account row to extract the 

account number from column B.  An example of the MID function is =MID(B12,16,4).  Then copy the 

formula down to all other account rows in column C.  Do a Copy Paste Values of the data in column 

C into column D.  This will ensure that the account numbers in column D are static values.  We will use 

these as the account numbers to reference in our Sage Intelligence formulas. 

4. Delete columns A, B and C of the layout.  It should now look as follows: 
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5. Replace the Account Descriptions now in column C with static values (i.e. Copy Paste Values) 

The Account Descriptions now in column C are currently derived from FR formulas which we do not 

want to use going forward as they will only return values while Statement Designer is open. 

a. Select all the Account Descriptions in column C 

b. Press CTRL C on your keyboard to copy the selection 

c. Right click on the first Account Description in the selection and click Paste Values under Paste 

Options in the menu that appears.  This will overwrite the current Account Descriptions with 

static values. 

 

6. Add Sage Intelligence formula to the layout. 

For each new data column do the following: 

a. Check the FR formula that is used in the corresponding FR data column 

 

b. Look up the corresponding Sage Intelligence formula in the FR to Sage Intelligence formula 

translation tables provided in section 4.0 of this guide 

c. Drag the formula from the Task Pane into the appropriate cell 
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d. Update the function arguments of the formula using the Function Arguments window

i. With the cell containing the formula selected, click the fx icon next to the formula bar.  The

Function Arguments window will open

ii. Set the Account field to the cell of the account number in column A of the row.  Press F4

three times to absolute reference the column

iii. Set the Company field to the cell containing the value for the Company in the report headings.

Press F4 once to absolute reference the cell

iv. Set the Year field to the cell containing the value for the Year in the report headings.  Press F4

once to absolute reference the cell

v. Set the Period field to the cell containing the value for the Period in the report headings.

Press F4 once to absolute reference the cell

vi. Set the CurrencyCode field to the cell that will contain the value for the Currency in the report

headings.  Press F4 once to absolute reference the cell

vii. Set the CurrencyType field to the cell that will contain the value for the Currency Type in the

report headings.  Press F4 once to absolute reference the cell

viii. Set the ReportTreeUnit field to the cell containing the value for the Reporting Tree Unit in the

report headings.  Press F4 once to absolute reference the cell

ix. Click OK to close the Function Arguments window
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The formula should now pull through the correct value. 

e. Copy the formula down to all account rows 

 

Note: Although in general, a column in a spec may use a single function, there are cases where it may 

use several different functions.  An example is an Income Statement which returns Net Year to Date 

figures but includes Order Inventory accounts.  The general formula for the column might be 

FRAMTA(“NETYTD”) but the formulas for the Opening and Closing Inventory accounts are 

FRAMTA(“BALOPEN”) and FRAMTA(“BALP”) respectively.  In these cases you need to take note of 

the FR formulas used and apply the correct Sage Intelligence formulas to the relevant account rows. 

f. Copy the format of the FR data column to the Sage Intelligence data column 

i. Click the column handle of the FR data column 

ii. Select the Format Painter tool from the Home tab on the Ribbon 

iii. Click the column handle of the Sage Intelligence data column 
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The reason for doing this is that in FR, negative numbers aren’t indicated with a minus sign but rather 

with brackets around the number.  If a Sage Intelligence formula that returns a negative number is 

placed in an unformatted cell, the number will show a minus sign.  Copying the formatting ensures 

that negative values in the Sage Intelligence data column are shows with brackets around them. 

7. Switch the sign of Sage Intelligence formula in relevant account rows 

You may notice that some of the values in the Sage Intelligence data column display as negative 

numbers when they show as positive numbers in their FR counterparts and vice versa.  This is because 

in FR, the sign for these accounts was switched using a minus sign; for example, with Revenue accounts 

in an Income Statement when using an FRAMTA function.  This can be confirmed by checking the sign 

of the FR formulas in the FR data column. 

 

To solve this place a minus sign at the start of all Sage Intelligence formula whose sign needs to be 

switched. 

 

Tip: In financial statements switching the sign is usually applied to account groups, like Revenue or 

Other Income and Expenses, rather than specific individual accounts.  When switching the sign for 

these groups, you can speed things up by switching the sign for one formula in the group and then 

copying the formula to all other rows in the group. 

8. Copy the formulas of all totals from FR data columns to Sage Intelligence data columns 
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9. Delete the FR data columns from the layout

10. Drag the Company Name, Current Year and Current Period formulas to their respective fields in the

report headings.  This way, when you next run out your report, the data will reflect the current

company, year and period

The layout should look as follows: 
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11. Add any more customisation you would like to finish off the layout

 Save the Layout to the Report 

The layout is now complete.  The last thing to do is save it back to the copy of the Financial Report 

Designer you made earlier. 

1. Go back to the Report Manager

2. Select the copy of the Financial Report Designer report you made

3. Click Save Excel Template on the Home tab

4. Select the Report Designer workbook from the list and click OK.
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5. Enter a new name for the template in the Specify Template Name dialogue and click OK

6. If the template saves without a problem the Completed Successfully dialogue will appear.  Click OK

to close it

7. Rename the report in Report Manager if you’d like to give it a name that better describes the report

 Extras 

Now that the transfer process is complete, you may want to add some additional features to your report. 

If you would like to hide or remove zero rows from your report every time it is run out then set up the 

ZeroingII add-in for the report.  Information on the add-in can be found in the Sage Intelligence help file 

under Home > Report Manager > Maintaining Reports > Add-In Functions > Add-In: ZeroingII. 

You may also want to create a reporting tree so that you can filter your layout based on the hierarchy of 

your business.  Information on reporting trees can be found in the help file under Home > Report 

Designer > Reporting Trees > What are Reporting Trees?  A number of videos can also be found on 

the Sage Intelligence YouTube channel.  Once you’ve created your tree you can apply it to your layout 

by dragging a reporting unit into the Reporting Tree Unit field in your report headings.  Because we set 

up the formulas to reference this cell, the values will automatically update to reflect the correct data. 

mk:@MSITStore:C:/Program%20Files/Sage/Sage%20300%20ERP/BX62A/BIRES/HELP/en/Alchemex.chm::/Help%20Introduction%20Alc.htm
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